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CAPITULO 1 

 

1.1 INTRODUCCION 

 

El almacenamiento de la información para su análisis a través de una computadora es 

ahora necesaria e imprescindible ya que esta es capaz de analizar una gran cantidad 

de información en muy poco tiempo, las empresas ya sea el giro al que pertenezcan 

para que estas funcionen y puedan tomar mejores decisiones requieren almacenar toda 

su información en bases de datos para una búsqueda más rápida  y clara de la misma y 

más aún si esta empresa procesa demasiada información y necesita analizarla 

estadísticamente para conocer los factores que le han producido un mejor rendimiento 

es decir todas las variables que puestas en cierto orden dan los mejores resultados. 

 

 

Este problema es el que precisamente queremos resolver  ya que si bien muchas 

empresas cuentan con sistemas de información otras que son relativamente nuevas 

como el IBEA no cuentan con tal y debido al giro de la empresa, nuestros 

conocimientos de la carrera ingeniería electrónica y conocimiento en materias de 

programación se pretender dar solución a esto y proporcionar un sistema que dé 

solución a sus problemas. 

 

 

Esta empresa debido al tipo de información que maneja, como se recaba y el volumen 

de la misma nos solicito un sistema parecido a los de los sistema de evaluación 

actuales en algunas universidades nos referimos en aquellas en el que el aspirante a 

ingresar rellena óvalos en una hoja de respuestas para después estas se almacenen y 

el sistema los califique. Esa es la idea principal diseñar un formato que se pueda 

rellenar y después pase por un sistema que lo lea, procese y finalmente lo almacene en 

una base de datos. 
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Existe hardware que hace más fácil esa tarea como los lectores OMR ó escáneres 

OMR que reconocen los óvalos rellenados y lo hacen en algunos modelos de forma 

muy rápida y de forma pro automática y así mismo software en el que se puede diseñar 

el molde de la hoja y que sea a través de un escáner convencional el procesamiento del 

mismo. 

 

 

Sin embargo debido al formato y tamaño de la hoja que se pretende tener (tamaño 

carta) los escáneres OMR  que nos facilitan esta tarea resultan sumamente caras y si 

se opta por el software para escáner convencional pues  dado al volumen de 

información se requiere un escáner con despachador automático y de las prestaciones 

que se necesitan el precio de estos equipos aunque menor que el escanee OMR sigue 

estando bastante elevado.    

 

 

Es por esto que la mejor manera es adquirir software para el diseño del formato para su 

lectura que no es tan elevado y en vez de adquirir un escáner convencional con 

despachador de hojas automática  nosotros diseñar el sistema electromecánico que 

capture la imagen y la almacene en la computadora y que la velocidad de la misma 

satisfaga los requerimientos de la empresa.   

 

 

1.2 JUSTIFICACION 

 

En el IBEA el capturar la información sobre huertos madre que se encuentra en 

formatos que son elaborados por técnicos de campo a un soporte digital resulta 

demasiado tedioso y lento, es por eso que el implementar un sistema electrónico de 
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captura de datos automático mejoraría en gran medida el manejo de la información 

trayendo como consecuencia mayores y mejores resultados en la producción. 

 

 

1.3 OBJETIVOS 

 

 

1.3.1 General 

 

Realizar un sistema capaz de interpretar por medio de captura de imágenes, datos en 

hojas que contienen información sobre huertos madre, a través de una cámara web y 

un dosificador de hojas. 

 

 

1.3.2 Específicos 

 

 Diseñar el formato de hoja de datos el cual será el estándar de la organización. 

 

 Realizar un sistema de captura de imágenes automático de hojas de datos que 

sea eficaz y eficiente. 

 

 Implementar un software de reconocimiento de marcas al sistema, si es 

necesario, desarrollar dicho software. 

 

 Diseñar un sistema de posicionamiento preciso de las hojas. 

 

 Diseñar un despachador de hojas que funcione de forma automatizada. 
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1.4 CARACTERIZACIÓN DEL ÁREA EN QUE PARTICIPÓ 

 

El proyecto se elaborará en el departamento de Dirección de Investigación y 

Transferencia Tecnológica en el INSTITUTO DE BIOENERGÉTICOS Y ENERGÍAS 

ALTERNATIVAS DEL ESTADO DE CHIAPAS 

 

Organigrama de la empresa: 

 

 

Figura 1: Organigrama del IBEA 
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1.5 PROBLEMAS A RESOLVER   

 

Este proyecto ha sido dividido de tres etapas las cuales son: el desarrollo del formato de 

nuestra hoja de datos, elaboración del software de lectura de datos y realizar el sistema 

de captura automática de las imágenes. 

 

 

ETAPA 1: DESARROLLO DEL FORMATO DE HOJA DE DATOS. 

 

En esta etapa se diseñará el formato de nuestra hoja de datos que contendrá toda la 

información de los huertos madre, la hoja estará conformada por preguntas con sus 

respectivas respuestas predeterminadas a seleccionar por medio de un círculo 

rellenable. 

 

 

Procedimiento: 

 

1. Recopilación de la información que contendrá el formato: Se investigará y 

planteará junto con la persona encargada de la administración de  la información 

de huertos madre lo que se considere que deberán contener las hojas de datos 

que llevarán los registros de las plantas. 

 

 

2. Elaboración del bosquejo del formato: Este formato inicial no se enfocará en el 

diseño para ser leído por los procesadores ópticos, en cambio se verá la 

magnitud de la cantidad de información que debe ir contenida y también como 

debe ir organizada para su mejor interpretación. 
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3. Elaboración del formato que será procesado: A partir del boceto anterior, se 

realizará el diseño para su lectura en el software de reconocimiento. Este diseño 

inicial puede no ser el definitivo, pero será totalmente útil para continuar con la 

realización del sistema. En este paso se diseñará marcas especiales y algunos 

otros ajustes para que nuestro programa pueda reconocer adecuadamente la 

hoja de datos y pueda leer la información en ella. 

 

 

ETAPA 2: ELABORACION DEL SOFTWARE DE LECTURA DE DATOS 

 

En esta etapa comprende principalmente en la elaboración de un software capaz de 

interpretar el archivo de imagen de una hoja de datos capturada previamente por 

nuestro sistema y que finalmente almacene los datos leídos en tablas 

 

 

Procedimiento: 

 

1. Elaboración del software de procesamiento de imágenes: Primeramente se 

diseñará el algoritmo para la identificación y lectura de  la hoja de datos y 

posteriormente se elaborará el programa que haga dicha tarea. 

 

 

2. Pruebas de eficiencia: Se realizaran pruebas como rapidez y exactitud de la 

lectura y captura con diversas condiciones en las hojas (posición, borrones, 

arrugas, etc.). 

 

 

3. Corrección y depuración del software: De los resultados obtenidos se adecuará el 

algoritmo y el programa a fin de obtener resultados satisfactorios. 
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ETAPA 3: AUTOMATIZACION DE CAPTURA DE IMAGENES 

 

Esta etapa comprenderá realizar un sistema que capture automáticamente una imagen 

de la hoja y suministre una siguiente hoja para una nueva captura, estará constituido 

principalmente por un despachador de hojas y una cámara web. 

 

 

Procedimiento: 

 

Diseño del sistema electromecánico: Aquí se ideará como es el proceso general de la 

captura y procesamiento de las hojas para así crear la estructura física del sistema. 

 

 

Elaboración del sistema electrónico: Consta de la realización del diagrama eléctrico y la 

circuitería necesaria. 

 

 

Elaboración del software de manipulación de la cámara web y el despachador: En ésta 

etapa se desarrollará el programa que disparará de modo automático a la cámara web 

para que tome la imagen de la hoja de datos, también el programa de suministro de las 

hojas. 

 

 

Búsqueda y adquisición de los componentes necesarios: Consta de buscar y conseguir 

todos los dispositivos y elementos necesarios que se requieran. 

 

 



 

 

8 

 

Construcción del sistema: Una vez se tengan todos los componentes se procederá al 

armado del sistema. 

 

 

Pruebas y correcciones: Aquí se corregirán los errores que surjan del sistema armado. 

 

 

 

Figura 2: Cronograma 

 

 

1.6 ALCANCES Y LIMITACIONES 

 

Se pretende con el proyecto dé pie para poder utilizar la información recabada  para un 

análisis a cada huerto y son ello conocer los diversos factores que influyen para que un 

huerto sea mejor que otro y así homogeneizar los huertos y obtener los mejores 



 

 

9 

 

resultados posibles en cada uno de ellos, sin embargo no es el objetivo principal del 

proyecto lograr esto sino una consecuencia del mismo y nosotros nos limitamos a 

ofrecer los datos recopilados de las hojas almacenados en una tabla en la computadora. 

 

 

El sistema es apropiado para demandas medianas de procesamiento de hojas (de 600 

hojas por hora), las hojas son de papel bond tamaño carta, y la impresión será laser 

para resultados más precisos. La bandeja soportara aprox. 100 hojas, debido al uso en 

licencia del software adicional se limitará su instalación a una máquina. Su 

funcionamiento será bajo una iluminación controlada, siendo necesario cubrir toda el 

área de captura para evitar el filtrado de luz externa. La cámara web deberá ser de alta 

resolución y que incluya un botón disparador a fin de que sea más fácil manipularla con 

un microcontrolador. 

 

 

CAPITULO 2 

 

2.1 FUNDAMENTO TEORICO 

 

 

CÁMARA WEB 

 

Una cámara web o webcam es una pequeña cámara digital conectada a una 

computadora, la cual puede capturar imágenes y transmitirlas a través de Internet en 

directo, ya sea a una página web o a otra u otras computadoras de forma privada. Las 

webcams necesitan una computadora para transmitir las imágenes. Sin embargo, 

existen otras cámaras autónomas que tan sólo necesitan un punto de acceso a la red 

informática, bien sea Ethernet o inalámbrico. Para diferenciarlas de la webcam o 

cámaras de web se las denomina netcam o cámaras de red. 

http://es.wikipedia.org/wiki/C%C3%A1mara_digital
http://es.wikipedia.org/wiki/Computadora
http://es.wikipedia.org/wiki/Internet
http://es.wikipedia.org/wiki/P%C3%A1gina_web
http://es.wikipedia.org/wiki/Ethernet
http://es.wikipedia.org/wiki/Red_inal%C3%A1mbrica
http://es.wikipedia.org/wiki/C%C3%A1mara_de_red
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Existen diversas aplicaciones que gracias a la proliferación de estos dispositivos y a su 

popularidad en su mayoría para videoconferencias y para seguridad, aunque también 

se les da otras aplicaciones mas especificas como el de reconocimiento de imágenes. 

 

 

Software 

 

Como se ha dicho, la instalación básica de una webcam consiste en una cámara digital 

conectada a una computadora, normalmente a través del puerto USB. Lo que hay que 

tener en cuenta es que dicha cámara no tiene nada de especial, es como el resto de 

cámaras digitales, y que lo que realmente le da el nombre de webcam es el software 

que la acompaña. El software de la webcam toma un fotograma "frame" de la cámara 

cada cierto tiempo (puede ser una imagen estática cada medio segundo) y la envía a 

otro punto para ser visualizada. 

 

 

RECONOCIMIENTO DE IMAGENES 

 

El reconocimiento de imágenes nos sirve para obtener información de una imagen (ya 

sea en tiempo real obteniéndose de una cámara web por ejemplo o de imágenes ya 

almacenadas en la computadora)  que nos sea útil y poder analizarla en un ordenador o 

en algún dispositivo que lo integre, existen muchas aplicaciones que van desde poder 

detectar rostros y cierta variantes incluidas en cámaras digitales y hasta algoritmos más 

complejos como patrones de comportamiento en imágenes en movimiento a través de 

cámaras web o de seguridad.  

 

 

http://es.wikipedia.org/wiki/Frame
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Existen programas para el reconocimiento facial estos  nos sirven para reconocer y 

detectar a personas que intentan ingresar en un sistema mediante el reconocimiento de 

sus rostros y comparación en una base de datos. Otro ejemplo de programas para 

reconocimiento de imágenes son los que aplican técnicas de OCR que nos sirven para 

a partir de una imagen que contiene texto interpretar éste y poder utilizarlo después. 

 

Existen muchos métodos y técnicas para el reconocimiento de imágenes que se 

diseñan dependiendo lo que se quiera hacer con dicha información, por ejemplo en el 

laboratorio MIT, han estado tratando de descubrir cuál es la cantidad mínima de 

información, o sea, la representación numérica más corta, extraíble de una imagen, que 

indique con suficiente certeza qué clase de contenido tiene. Se espera que esto ayude 

a la idea de hacer posible la catalogación automática de los miles de millones de 

imágenes alojadas en internet. 

 

 

APLICACIONES DE SISTEMAS BASADOS EN RECONOCIMIENTO DE IMÁGENES  

 

Ayudas técnicas de acceso al ordenador basadas en cámaras web 

 

Algunas personas con problemas de control motriz u otras discapacidades tienen 

dificultades para utilizar el teclado, el ratón y otros periféricos estándar para la entrada 

de datos al ordenador. Estas personas requieren ayudas técnicas específicas como 

teclados especiales, ratones controlados por un joystick y en los casos más graves 

programas con sistema de barrido controlados por un pulsador. Los siguientes sistemas 

permiten una mayor independencia física de la persona respecto al ordenador personas 

con alguna discapacidad determinada. 

 

 

WebColor Detector 
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En su forma final es un componente de programación, una DLL que se instala en el 

ordenador y que puede ser utilizado por terceros programas.  El sistema WebColor 

Detector es capaz de identificar la presencia o ausencia de una  marca de un color 

determinado,  en el campo visual de una cámara web, y retornar las coordenadas de su 

posición. Con tan simple mecanismo se puede emular un pulsador o joystick de 

cualquier tipo sin necesidad de instalar ningún artilugio más. Con éste sistema se puede 

realizar: 

 

 

Pulsador virtual 

 

WebColor Detector puede actuar como un pulsador virtual, sin necesidad de cables que 

se podrá  ajustar a las necesidades de la  mayoría  de usuarios. El pulsador físico se 

convierte en una marca de color, que puede estar fija en el suelo o en el mobiliario o  en 

el propio usuario en forma de complemento del vestir, por ejemplo un reloj, una gorra, 

una cinta del pelo, un pin, un dedal de color  o una pegatina de color.  

 

 

El ordenador controla presencia o ausencia de la marca de color a distancia, sin 

necesidades de cables. Cuando el usuario tapa o destapa la marca de color o el 

complemento entra el en el campo visual de la cámara web, el programa  ejecuta el clic 

como lo haría cualquier programa  

 

 

Mouse o joystick virtual 

 

WebColor Detector puede controlar del cursor de la pantalla como si trabajásemos con 

un mouse o un joystick. Para esta finalidad fijamos la marca de color en la mano del 

usuario que maneja una joystick físico, como puede ser el de la silla de ruedas, 

señalara las direcciones en un tablero o simplemente moverá la mano en el aire. El 
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sistema traduce el desplazamiento de la marca de color en desplazamiento de cursor 

del mouse que se puede situar a voluntad en cualquier punto de la pantalla. 

 

 

Cuando la marca permanece estable durante un cierto tiempo  el sistema inicia una 

cuenta atrás que finaliza haciendo clic del ratón. Si se sigue manteniendo la estabilidad 

de la marca se inicia el proceso de doble clic del ratón. Naturalmente existen diferentes 

parámetros que permiten  ajustar los tiempos y desplazamiento de la marca de color, 

con los movimientos del cursor. 

Igualmente existe un sistema gráfico que informa de cuando se va a producir un clic o 

un doble clic. 

 

 

Ratón Facial 

 

Ratón Facial es un programa de ordenador que reproduce las funciones del ratón físico 

convencional: mueve el puntero y hace clic. Ratón Facial permite interactuar 

completamente con el ordenador, pero todo ello sin utilizar las manos y sin necesidad 

de marcas, cables, sensores u otros molestos accesorios. 

 

 

Ratón Facial funciona de la siguiente forma: 

 

 

Movimiento del puntero: Mediante una WEBCAM USB estándar, el Ratón Facial mueve 

el puntero por la pantalla analizando los movimientos de una parte del cuerpo, 

usualmente la cabeza. 
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El clic: El Ratón Facial reproduce las acciones de clic escogiendo uno de estos 2 

métodos:  

 

 

Límite de tiempo (Timeclick), deteniendo el puntero durante un instante en la zona 

donde quiera hacer clic. 

 

 

Orden de Voz (VoiceClick), emitiendo un sonido cualquiera (un soplo o una palabra) a 

un micrófono convencional conectado a una tarjeta de sonido. Este método es capaz de 

distinguir entre clic izquierdo (sonido corto) y clic derecho (sonido largo).  

 

 

Programas de reconocimiento facial 

 

Facecode 2.1.4 

 

FaceCode es una aplicación que recurre al reconocimiento facial para proporcionar 

acceso al equipo. El programa analiza la señal de vídeo procedente de una webcam y 

la compara con la imagen que tiene asignada el usuario en la base de datos. Si ésta no 

coincide, no podrá acceder al sistema. 

 

 

FaceCode representa por tanto un sistema de autenticación biométrica que recurre a 

los rasgos faciales para autentificar al usuario. Éste deberá calibrar previamente el 

programa para un correcto funcionamiento. En el reconocimiento facial, FaceCode 

puede combinarse con una palabra de paso y nombre de usuario. 
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Figura 3: Pantalla principal del programa Facecode 2.1.4 

 

 

 

Reconocimiento de de caracteres 

 

 

TopOCR 2.5  

 

TopOCR es una herramienta de reconocimiento óptico de caracteres que te permite 

obtener el texto contenido en una imagen determinada. Su uso evita tener que copiar de 

forma manual el texto. La captura puede realizarse tanto de documentos completos 

como de partes de estos, gracias a una herramienta de selección. Los caracteres se 

exportan a un procesador de textos propio que incluye el programa, desde el que es 

posible modificar su formato. 
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La interfaz del programa se compone de dos ventanas. En la de la izquierda se muestra 

la imagen original. En la derecha el usuario puede ir formateando el texto que extrae de 

la imagen. 

 

 

TopOCR está preparado para trabajar fundamentalmente con las imágenes 

procedentes de una cámara digital o un teléfono móvil. 

 

 

Figura 4: Espacio de trabajo del programa TopOCR 2.5 

 

 

LECTURA OPTICA 

 

ICR, OCR y OMR son todos métodos orientados a disminuir la cantidad de entradas de 

datos manual en ambientes de procesamiento de formularios. ICR y OCR son 

dispositivos de reconocimiento usados con imágenes. OMR es una tecnología de 

captura de datos que no requiere un dispositivo de reconocimiento, es utilizada cuando 

se requiere un alto grado de rapidez y precisión. 
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ICR – Reconocimiento de Caracteres Inteligente 

La tecnología ICR proporciona a los sistemas de reproducción por escáner y sistemas 

de imágenes la habilidad de convertir caracteres en letra manuscrita (no cursiva) en 

caracteres capaces de ser interpretados o reconocidos por una computadora. Así, las 

imágenes de caracteres en letra manuscrita son extraídas de un mapa de bits de la 

imagen reproducida por el escáner. Existen diversos dispositivos de reconocimiento ICR 

en el mercado.  

 

 

OCR – Reconocimiento de Caracteres Ópticos 

La tecnología OCR proporciona a los sistemas de reproducción por escáner y sistemas 

de imágenes la habilidad de convertir imágenes de caracteres en letra de máquina, en 

caracteres capaces de ser interpretados o reconocidos por una computadora. Así, las 

imágenes de caracteres en letra de máquina son extraídas de un mapa de bits de la 

imagen reproducida por el escáner.  

 

 

OMR – Lectura de Marcas Ópticas 

La tecnología OMR detecta la ausencia o presencia de una marca (pero no procesa la 

forma de la marca) en un formato óptico previamente diseñado y el software interpreta 

la imagen del escáner. Los formularios contienen pequeños círculos, llamados 

“alvéolos”, que son rellenados por la persona encargada de llenar el formulario y que 

serán posteriormente interpretados por el software. 

 

 

El funcionamiento es el siguiente: Una simple marca con lápiz grafito o pasta se hace 

sobre un formulario para indicar las respuestas (alternativas) escogidas a preguntas de 

una encuesta o examen. Los formularios que se completan son leídos por el lector 

óptico de marcas el cual detecta la presencia de marcas midiendo la luz que se refleja 
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sobre el formulario. El LECTOR entonces, interpreta las marcas en base a una plantilla 

y envía esta información a la computadora para ser almacenada y analizada. 

 

 

La tecnología OMR ha sido ampliamente utilizada desde la década de los 70's para 

distintos propósitos, incluyendo pruebas escolares y universitarias, censos, encuestas y 

sorteos, así como para votar. También se utiliza en lectores de código de barras, que se 

utilizan comúnmente en comercios, bibliotecas y escuelas. 

 

 

Usos de la tecnología OMR 

 

El uso de formularios de alternativas tiene un sin fin de aplicaciones. Todo proceso de 

recolección de datos que se pueda llevar a un formulario de alternativas es una 

aplicación para la OMR. Las ventajas de utilizar OMR son claras: rapidez, seguridad y 

bajos costos. Se pueden distinguir variadas aplicaciones que representan la 

funcionalidad de la OMR: 

  

 Test de Alternativas múltiples.  

 Evaluaciones docentes.  

 Test de Intereses Vocacionales  

 Encuestas.  

 Test Sicológicos  

 Control de Mermas o Scrap  

 Selección de Personal  

 Estudios de Mercado  

 Control de Asistencia  

 Juegos de Azar, etc.  
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A continuación mostraremos algunas de estas: 

 

Encuestas 

 

La más directa de las aplicaciones son las encuestas, los resultados se pueden 

procesar rápidamente y dedicar el valioso tiempo de digitación al análisis de resultados.  

Este formulario consta de 2 tipos de preguntas: únicas y múltiples. Una pregunta única 

es aquella donde se puede marcar solo una alternativa. Una pregunta de tipo múltiple 

acepta una o más alternativas. 

 

 

 

Figura 5: Ejemplo de encuesta basado en lectura OMR. 
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Tests psicológicos y de orientación  vocacional 

 

Las instituciones que más utilizan estas aplicaciones son las de educación, tales como 

Colegios, Universidades, Institutos, Escuelas de Capacitación, Escuelas de las FFAA, 

etc. 

 

 

 

Figura 6: Ejemplo de hoja de respuestas basado en lectura OMR. 
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Controles de calidad y producción 

 

Cartilla empleada para controlar el estado de productos en proceso. De esta forma se 

pueden tener estadísticas detalladas de aspectos tipificados con anterioridad. De esta 

misma forma se podrían desarrollar cartolas para control o test de calidad de productos 

terminados. 

 

 

 

Figura 7: Ejemplo de control de calidad basado en lectura OMR. 

 

 

Cuando se tienen muchos puntos de control de productividad dentro de una misma 

empresa, el relevo de información demanda grandes inversiones en tecnología para la 

captura de los datos en todos los puntos. Sin embargo el sistema de llenado de tarjetas 

con tecnología OMR por cada punto con la información de la producción hace 

muchísimo más simple y económico que cualquier otra alternativa. Esta técnica se 

utiliza también muy convenientemente para la medición de la NO Calidad a través de 

cuantización de la merma. 

Otra aplicación muy interesante y conveniente tiene que ver con el registro de las 

"variables de los procesos". Los operadores pueden registrar la evolución de estas 
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variables en simples cartillas, donde la visualización gráfica también queda de 

manifiesto, permitiendo además ingresar estos datos y gráficos rápidamente a los 

sistemas informáticos de la empresa a través del lector OMR. 

 

 

 

 

Figura 8: Ejemplo de planilla de control de calidad basado en lectura OMR. 
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Sistemas de Votación Mecánicos y Electrónicos 

 

 

Existen distintas clases de sistemas de votación mecánicos y electrónicos. Algunos de 

ellos utilizan tecnologías desarrolladas especialmente para propósitos electorales. La 

votación mecánica o electrónica es utilizada ampliamente en los Estados Unidos y en 

menor medida en otro pequeño grupo de países de otras partes del mundo. 

 

 

La mayoría de los sistemas de votación basados en máquinas lectoras (escaneo óptico) 

utilizan tecnología OMR. En los Estados Unidos son conocidos como sistemas 

"Marksense".  

 

 

A los electores que utilizan papeletas de lector óptico se les da una tarjeta con los 

nombres de los candidatos impresos en ella. Al lado de cada candidato se imprime 

algún símbolo como un rectángulo, un círculo o una flecha incompleta. El candidato 

indica su preferencia rellenando el símbolo correspondiente o completando la fecha.  

 

 

Después de votar, el elector puede colocar directamente la tarjeta en una computadora 

que tabula los votos en el mismo sitio de votación, o colocarla en una urna que luego es 

transportada a un centro de conteo. El dispositivo de conteo identifica las marcas 

hechas por los votantes en las tarjetas y registra los votos según corresponda. Los 

votos individuales son registrados en una base de datos y consolidados para 

proporcionar resultados totales.  

 

Los sistemas "Marksense" o de marcado sensible fueron utilizados por el 24.65 de los 

electores registrados en las elecciones presidenciales estadounidenses de 1996. Su 
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uso es cada vez más extenso en reemplazo de los sistemas de palancas y tarjetas 

perforadas.  

 

 

CAPITULO 3 

 

 

3.1 PROCEDIMIENTO Y DESCRIPCIÓN DE LAS ACTIVIDADES 

REALIZADAS 

 

 

3.1.1 ETAPA 1: “DISEÑO DE UN PROTOCOLO DE INVESTIGACIÓN COMPLETO”  

 

En la empresa necesitaban conseguir  los recursos necesarios y para ello el protocolo 

tenía que estar completo a fin de convencer a los patrocinadores  por lo que se dedico 

bastante  tiempo a esto es decir a investigar más sobre el marco conceptual y darle una 

mejor presentación al mismo. 

 

 

Lo que tratábamos era de justificar que nuestro proyecto era posible dado a que 

encontramos muchos sistemas de reconocimiento de imágenes los cuales eran más 

complejos que el que nosotros queríamos realizar y así dar por sentado que podíamos 

realizarlo sin mayores inconvenientes también se analizaron otro tipo de reconocimiento 

de imágenes por medio de cámara web y pues también llegamos a la conclusión que 

podríamos alcanzar nuestras metas utilizando cámara web. 
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También analizamos otras propuestas que era el uso de escáneres OMR pero los que 

cubrían los requisitos  que nosotros buscábamos llegaban a ser excesivamente caros 

por lo tanto no era viable para la empresa desarrollar ese tipo de sistema.  

Entonces una vez con las ideas más claras acerca del sistema en general se modifico el 

protocolo y este se entregó como nuestro primer reporte a nuestro asesor y a nuestro 

jefe en el IBEA. 

 

 

3.1.2 ETAPA 2: “DESARROLLO DEL FORMATO DE HOJA DE DATOS”   

 

En esta etapa se conocieron los aspectos fundamentales que un técnico de campo 

recaba de los huertos que se le asignan y los concentra en un reporte el cual es 

entregado y archivado en cajas de manera impresa, el problema con esto es que a la 

persona que recibe dicha información no hace nada con ella es decir no la analiza 

debido a su mala organización como para poder tomar decisiones con ella es por eso la 

preocupación de la institución poder contar posteriormente con un sistema que les 

permita analizar de manera grafica situaciones y así tomar las decisiones pertinentes 

pero antes claro nosotros debemos almacenar digitalmente la información para que 

después se pueda manipular. 

 

 

En conjunto con los técnicos de campo que se encargan de dar seguimiento a los 

huertos madre desde su siembra hasta la cosecha se discutió su formato preestablecido 

(ver figura 9)  en cuanto a su funcionalidad y mejora del mismo. 

 

 

Una vez llegado a un acuerdo empezamos a trabajar en el formato de hoja de datos 

que será escaneado en la manera de cómo poner cada concepto y de hecho se analizó 

que la primera parte de ella se podía eliminar (hasta método de siembra) se eliminarían 

casi todo es decir cómo eran datos que no cambiaban podía haber un identificador el 
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cual se pudiera conocer todos los datos no cambiantes. La segunda parte eran datos 

que en su mayoría cambiarían contantemente o podía pasar un corto tiempo para que 

cambiaran por lo tanto esas serían las que de ninguna forma se podrían eliminar.  

 

 

Con la información que teníamos se diseño nuestro formato en base a alveolos (óvalos 

rellenables) que se ilustra en la figura 10. Como identificador de los campos no 

cambiantes es decir características propias de cada huerto serían simplemente la 

comparación de dos conceptos es decir basta con saber el nombre del técnico (que se 

encuentra como el ovalo que este rellenado del apartado de nombres) más el numero 

de huerto y así se puede conocer todo lo demás pues cada técnico tiene enumerado 

sus huertos y si se sabe ambas cosas se sabe de qué huerto estamos hablando pues 

se conocerá su localización, las medidas del terreno, datos técnicos del lugar tipo de 

siembre etc.   

 

 

Como medida de seguridad agregamos un código de barras en especifico el código de 

barras número 39 por ser el más usado y que sabíamos que no tendríamos problemas 

en su lectura o en encontrar información en él, se tomo esta decisión pues no queremos 

que haya datos duplicados en la base de datos y así se nos informara esto y una misma 

hoja no podrá ser leída 2 veces. 

 

 

3.1.3 ETAPA 3: “ELABORACIÓN DEL SOFTWARE DE LECTURA DE DATOS”. 

 

 

En el presente reporte se contemplan los avances hasta el 3 de noviembre del 2008. 

 

 Antes que nada cabe señalar que sufrió un cambio significativo esta etapa que 

antes estaba dividida en los siguientes pasos: 
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 Elaboración del software de procesamiento de imágenes 

 Pruebas de eficiencia 

 Corrección y depuración de Software. 

El cambió se debió a que se analizaron formas de programar el procesamiento del 

formato a leer y en nuestra investigación dimos con programas cuya principal objetivo 

es la de diseñar un formato el cuál  pueda leer formatos de tipo OMR y almacenar en 

tablas la información extraída. 

 

 

Se invirtió bastante tiempo en la búsqueda de los mismos y entre los principales 

podemos recalcar cuatro el PC OMR 8, SCAN FIX 5, TELEFORM y REMARK OFICCE 

OMR 6 

 

 

La principal razón de esta búsqueda fue debido a nuestro perfil de ingeniería en 

electrónica y que sería más fácil para nosotros apoyarnos de dicho software para 

avanzar mayormente en el apartado que involucrara electrónica que es la siguiente 

etapa. Se analizaron los programas mencionados anteriormente en ellos el de mejor 

relación  calidad precio  fue Remark oficce OMR 6 en el que se ahondo en su uso al 

este ser el más intuitivo y amigable al usuario y respaldado por su uso en empresas de 

renombre internacional un ejemplo de ello Microsoft que según la empresa creadora del 

software asegura que ellos utilizan su software para diversos propósitos como 

encuestas. 

 

 

Se planteó la propuesta de utilizar dicho software a nuestro jefe y mencionarle la 

ventaja que implicaría debido a su fácil manejo y que resulta muy útil para futuros 

cambios en el formato, nuestro jefe acepto la idea por lo que se rediseño el esquema de 
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trabajo en esta etapa y se empezó a utilizar el software con la limitante de que 

estábamos trabajando en su versión demo y no nos permitiría su exportación a ningún 

tipo de tabla para utilizarlo en visual basic .net 2008. Para  exportar a tabla se debe de 

comprar la licencia, sin embargo la versión demo nos permite diseñar el formato y 

programarlo en la forma que queremos que procese las hojas y con esto se lograban 

buenos avances. 

 

 

Debido a estos cambios se opto por el siguiente esquema de trabajo que 

posteriormente se explicara uno a uno en detalle: 

 

 Uso del Remark  Oficce OMR 6 (para la programación y lectura de las hojas de 

datos) 

 Pruebas de eficiencia 

 Rediseño de formato 

 

 

USO DEL REMARK OFICCE OMR 6  

 

En este paso ya decididos a  utilizar dicho software se aprendió a usar sino al 100 % 

por lo menos lo suficiente para poder manipular el archivo  en Corel (archivo que 

contiene el formato de hoja de datos) y plasmarlo en el programa y definir todos los 

criterios necesarios de cómo queríamos que se hiciera la lectura. 

 

La forma de usar el programa básicamente reside en dos entornos en uno se carga la 

imagen que se diseño y es donde se programa por regiones (ver figura 11), en cada 

región se definen propiedades en los que se especifica como lo tiene que leer y que 

valores nos tiene que devolver según se haya asignado a cada ovalo. 
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Primeramente hicimos pruebas con formatos simples para observar cómo se 

comportaba la lectura y de qué forma podíamos cambiar en una misma región como 

obtener valores diferentes, esto se logra modificando las propiedades de dicha región.  

 

 

Una vez diseñada nuestra hoja de datos en corel se exporta a 300 ppp la cargamos en 

el programa Remark, después se ubicaron las regiones en la hoja para cada aspecto 

que se deseó obtener información y se guardó todo el trabajo pues nos servirá como 

molde para cuando queramos leer las hojas en un segundo entorno,   

Una vez hecho esto se procede a utilizar el segundo entorno (ver figura 12) del 

programa el cual basta con cargar el molde que se creó y decirle que se van a leer 

hojas a partir de este molde, para esto llenamos a lápiz y lapicero varias hojas de 

prueba que imprimimos de nuestra hoja de datos diseñada posteriormente las 

escaneamos y así le decimos a este entorno del Remark que las tome las imágenes 

escaneadas para leerlas, y así observar dicho comportamiento. 

 

 

PRUEBAS DE EFICIENCIA 

 

Lo anterior se tomó como  primera prueba, se observaron los resultados obtenidos en el 

cual no se obtuvieron los esperados, se hicieron muchas más pruebas del mismo tipo 

se llenaron hojas con lápiz y diversos colores de lapicero incluso a computadora y se 

llego a la conclusión que no era por el llenado del mismo sino por errores sistemáticos 

del programa pues si bien cuando una región cumple con las características se 

presenta de color verde o de otro color dependiendo el tipo de lectura pero si se pone 

en rojo quiere decir que hay algo que hace que la región no se pueda leer por lo que se 

debe de encontrar la forma de llegar al color que caracteriza a la región como una 

candidata para lectura óptima, nosotros teníamos todas las regiones en estado correcto 
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ninguna en roja pero después de observar los valores que nos arrojaba se llegaron a 

una conclusión aún más importante el “rediseño del formato”.     

 

 

REDISEÑO DEL FORMATO 

 

Se analizó el porqué y se llego a la conclusión que era por tener márgenes muy 

pequeños a la hora de definir regiones y Remark tiene problemas si una región que ha 

sido aceptada como buena está demasiado pegada al borde de otra pero es a penas 

por fracciones de milímetros por lo que el carácter de la problemática nos llevo a  

rediseñar el formato en Corel para obtener más libertad en Remark al momento de 

establecer regiones de lectura ya que la cantidad de información hace que el espacio 

sea ajustado entre un concepto y otro, se corrigió el problema después de varios 

intentos  y se logro obtener excelentes resultados en la lectura después de esto también 

se opto por no incluir marcas en el diseño final para su reorientación en caso de ser 

necesario  ya que Remark es inteligente en ese sentido para buscar regiones de lectura 

dándole gran margen individual aparte del que nosotros definimos y en casos aislados 

en los cuales se haya puesto la hoja en sentido contrario o exageradamente 

desalineado, en el programa en su visualizador nos daremos cuenta por los errores que 

arroje y esa hoja en particular posteriormente se puede volver a colocar siendo mejor 

así para ahorrar valioso segundos al no reorientar después del escaneo con un 

programa aparte. El formato final se puede apreciar en la  figura 13. 

 

 

3.1.4 CUARTA ETAPA: “AUTOMATIZACIÓN DE CAPTURA DE IMÁGENES” 

 

Ésta etapa constó de los siguientes pasos: 

 

 DISEÑO DEL SISTEMA ELECTROMECÁNICO 

 ELABORACIÓN DEL SISTEMA ELECTRÓNICO 
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 SOFTWARE DE CÁMARA WEB Y DESPACHADOR  

Inicialmente se habían considerado 6 pasos como está considerado y plasmado en el 

cronograma pero debido a que el recurso no fue entregado se omitieron en esta etapa. 

 

 

DISEÑO DEL SISTEMA ELECTROMECÁNICO 

 

Aquí decidimos como iba a estar conformado físicamente nuestro sistema la manera en 

que iban a estar distribuidos los componentes tales como la cámara web, la bandeja 

que sostiene las hojas de datos, la posición de los sensores la posición de los motores y 

de la lámpara que ilumina el área en donde se captura la imagen y asimismo la 

ubicación de la circuitería y demás componentes secundarios. 

Podemos apreciar  un bosquejo de nuestro sistema desde su vista interna  y otra de su 

vista externa en las  figuras 14 y 15. 

 

 

De acuerdo a como van ocurriendo los hechos es decir desde que se enciende el 

sistema e inicia el proceso hasta que este termina iremos explicando que está 

ocurriendo y los dispositivos que intervienen. 

 

 

Primeramente se enciende el sistema y se verifica que existan hojas en la bandeja con 

dos pares de sensores infrarrojos si no hay hojas el sistema no puede iniciar pero si hay  

colocadas inicia el proceso el cual echa a andar el primer motor de cd que hace girar a 

un rodillo que se encuentra enfrente de las hojas y se asegura de solo jalar una hoja a 

la vez  apoyándose de un hule situado en la base de la bandeja que ejerce fricción y 

que ayuda a evitar que se jale más de una hoja y al mismo tiempo se echa a andar al 

otro motor de cd que es el encargado de hacer mover a los cinco rodillos encargados de 

transportar la hoja. Para mayor seguridad el trayecto de estos rodillos están cercados 

por dos paredes que hacen que la hoja siga un camino derecho y no se gire ligeramente. 
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Después  existen otros dos pares de sensores que se encargan de verificar   que si el 

primer motor  se echo a andar y  después de cierto tiempo estos censores no detectan 

a la hoja significara que ocurrió un problema de atasco y se informara en un LCD y se 

podrá resolver de dos formas una de ellas debido a que el sistema sigue intentando 

funcionar podría ocurrir que la hoja se desatascara por si misma pero si esto no ocurre 

se tiene que presionar el push que corresponde al paro de emergencia y que deja en 

condiciones iniciales al sistema por lo que habría que colocar la hoja de nuevo en la 

bandeja para volver a iniciar el proceso si no ocurre tal atasco el primer motor se 

detiene y solo queda funcionando el segundo que controla a los demás rodillos. 

 

 

Si pasa por el segundo par de sensores de manera exitosa la hoja se desplazara hasta 

un tercer par de sensores que son los que delimitan la posición de la hoja pues es ahí 

donde se toma la foto, cuando estos sensores detectan la hoja el segundo motor se 

detiene y la hoja queda fija y se manda a disparar a la cámara web se  espera unas 

fracciones de segundo más para asegurarse de que las fotos no salgan movidas y  se 

vuelven a hacer girar los rodillos para retirar la hoja. 

 

 

Una vez  tomada la foto y vuelto a poner en marcha al segundo motor hay un último par 

de sensores que se asegura que  la hoja sea retirada del sistema por completo si los 

sensores no ven a la hoja poco tiempo después que ocurrió la captura de la hoja esto 

indicara un atasco el cual se podrá solucionar de dos formas la primera que por sí 

mismo se desatasque o presionando el paro de emergencia y volver a colocar a la hoja 

en la bandeja, si  los sensores detectaron a la hoja se echa a andar el primer motor 

siempre y cuando haya por lo menos una hoja y se inicia de nuevo el proceso mientras 

es retirada por completo la anterior. 
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El sistema incluye un botón que se denominó “detener” esto es por si decidimos 

terminar con el proceso aun habiendo hojas en el sistema y se podrá oprimir una vez 

que el primer motor fue echado a andar indicando que esta es la ultima hoja a procesar.  

  

 

ELABORACIÓN DEL SISTEMA ELECTRÓNICO 

 Esta fase comprende el diseño del circuito eléctrico general  y  la elaboración de las 

placas figuras 16,17 y 18. 

 

 

SOFTWARE DE CÁMARA WEB Y DESPACHADOR 

 

En este paso se elaboro el código del programa que rige al PIC16F87A  y que hace que 

nuestro sistema funcione apropiadamente, este fue programado en Micro C  (ver código 

al final del capítulo 4). 

 

 

CAPITULO 4 

 

4.1 RESULTADOS, PLANOS, GRÁFICAS, PROTOTIPOS Y 

PROGRAMAS 

 

 

A continuación se presenta el último formato con el cual los técnicos presentaban sus 

reportes quincenales de sus huertos. 
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FICHA DE SEGUIMIENTO DE HUERTOS 

DE PIÑON (Jatropha curcas L.) 

CEDULA DE INDENTIFICACION 

HUERTOS MADRE DE PIÑON (Jatropha curcas L.). 

DATOS BASICOS 

 No. de Huerto  

FECHA:  

 

Nombre del 

Huerto: 

 

Localizació

n: 
 

Localidad:  

Municipio:  

 

GEOREFERENCIACION 

Coordenadas UTM. 

X Y 

  

DATUM:  Altitud (m.s.n.m.)  

 

DATOS CLIMATOLOGICOS 

Tipo de vegetación:  

Tipo de Clima:  

Tmx. Anual (°C):  

Temperatura 

ambiental promedio 

(°C): 

 

Tmn. Anual (°C):  T. mes seco (°C):  
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                                  HUERTOS MADRE DE PIÑON (Jatropha curcas L.). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Humedad relativa:  
Precipitación Pluvial 

anual (mm): 
 

Textura del suelo:  PH. Suelo:  

METODO DE SIEMBRA 

Fecha de siembra:  
Método de 

Siembra: 
 

Sustrat

o: 
 

Fecha de 

establecimiento:  
 

Superficie sembrada 

(Ha): 
 

Distancia entre 

Hileras: 
 

Distancia entre 

Plantas: 
 

Producción estimada 

en Plantación: 
 

Producción estimada 

por arbusto: 
 

OBSERVACIONES: 
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                      FICHA DE SEGUIMIENTO DE HUERTOS DE PIÑON (Jatropha 

curcas L.) 

EVALUACION FENOLOGICA Y AGRONOMICA 

 

VARIABLES A MEDIR EN EL CULTIVO 

Edad de la plantación:  
Densidad de la 

Población: 
 

% de Sobrevivencia:  
Altura Promedio de 

Plantas (m): 
 

Crecimiento Mensual 

promedio (cm). 
 

Cobertura promedio de 

plantas: 
 

Diámetro promedio del 

tallo: 
 

N°. de Ramas 

promedio por planta: 
 

Longitud Promedio de 

ramas por Planta: 
 

Promedio de N° de 

Yemas Florales por 

Arbusto 

 

N° de Cápsulas 

promedio por Arbusto 
 

% Promedio de 

Amarre de Frutos 
 

Promedio de Frutos 

Maduros por Arbusto 
 

Peso promedio de 

Cápsulas por arbusto 
 

Peso promedio de la 

Cápsula 
 

Promedio de semillas 

por arbusto: 
 

Fase 

Fenológic

a. 

Nacimient

o 
Floración 

Fructificaci

ón 

Amarilleo 

de las 

hojas 

Caída de 

las Hojas 

Maduraci

ón 
Cosecha 

Fecha de 

inicio 
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Peso de Semillas por 

arbusto: 
 

Promedio de semillas 

por Capsula 
 

Relación cápsula-semilla  
Accesibilidad entre 

surcos 

Buena (  ) Regular (  ) 

Mala (  ) 

Producción obtenida en 

Plantación: 
 

Producción Obtenida 

por Arbusto: 
 

SANIDAD 

Plaga:    
Enfermedad: 

                                  

Síntomas: 

  

Agente 

Causal: 
 

Área de Localización 

en la plantación: 
 

Área de Localización 

en Arbusto Muestra: 
 

Valoración de la 

incidencia: 
Leve   (      )  Moderado    (     )     Severo     (     ) 

Daño por Presencia de 

Fuego o exceso de 

lluvias: 

Leve   (     )  Moderado    (     )     Severo     (     ) 

Valoración de Daño a 

Frutos: 
Leve   (     )  Moderado    (     )     Severo     (     ) 

Observador:  

OBSERVACIONES: 

 

 

 

Figura 9: Formato habitual de huertos madre. 
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Figura 10: Primer prototipo de formato de huertos madre basado en alveolos. 
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La imagen ilustrada abajo corresponde a uno de los entornos del programa Remark que 

consiste en el área de diseño en el  cuál se programan  las zonas OMR para que estas 

al ser leídas nos devuelvan  los datos en la forma que queremos. 

 

 

 

Figura 11: Entorno de diseño de Remark Office OMR  6. 

 

 

Las zonas se transforman en color verde si corresponden a zonas del tipo OMR ya que 

hay de más tipos como el de código de barras que se pone en  naranja. Y estas zonas 

al modificar sus propiedades cambian el valor de los datos que nos arrojan es decir 
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puede multiplicar números y devolvernos el resultados o simplemente sumarlos o poner 

consecutivamente uno con otro etc. 

 

 

La imagen de abajo representa el segundo entorno en el cual trabaja el programa 

Remark en este se van almacenando los datos leídos y se presenta en la parte de abajo 

un visor de las áreas que fue leyendo en caso de algún error de llenado en la tabla se 

ve la imagen en la parte de abajo y se descifra el porqué del error. 

 

 

Figura 12: Entorno de lectura de datos y visualización de errores de Remark Office 

OMR 6. 
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Figura 13: Formato final de la hoja de huertos madre 
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Las figuras 14 y 15 presentan una vista interna y externa respectivamente, de nuestro 

sistema. 

 

Figura 14: Sistema de captura de hojas de datos (vista interna) 

 

Figura 15: Sistema de captura de hojas de datos (vista externa) 
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Figura 16: Circuito eléctrico general. 

 

Figura 17: Diseño esquemático del circuito. 
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Figura 18: Circuito impreso. 
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Por último en este capítulo presentamos el diagrama de flujo del programa desarrollado 

en Micro C para que nuestro sistema funcione de forma correcta. 
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CAPITULO 5 

 

5.1 CONCLUSIONES Y RECOMENDACIONES. 

 

Con el siguiente reporte se demuestra que sí es posible realizar un sistema automático 

de captura de información, siempre y cuando se defina de manera estricta la forma en 

que se presentará la información a ser capturada, y acorde a ello, irán los elementos 

necesarios que compondrán nuestro sistema y también el proceso lógico de su 

funcionamiento. En nuestro caso fue un sistema de captura de información de hojas de 

datos con la información de los huertos madre de los cultivos de piñón; la información al 

estar presentada en hojas, se eligió por leer la información pero no sin antes convertirla 

a un formato digital para mayores posibilidades de análisis y procesamiento, el uso de 

una cámara web en el proceso de cambio de formato, permite llevar a cabo esta tarea 

de forma casi instantánea; y para su correcta lectura se estableció un formato de hoja 

de datos; todos estos elementos propiciaron mucha facilidad a la hora de elegir como 

seria el proceso completo de captura de datos. 

 

 

La parte que es mas mejorable es en cuanto a la rapidez del movimiento de las hojas, si 

bien, inicialmente 600 hojas por hora pueden parecer muchas hojas por hora (para la 

utilidad pensada en nuestro proyecto es más que suficiente), es posible que si se 

pretende utilizar este sistema en otras aplicaciones, puede parecer hasta poco. 

 

 

Se recomienda en el caso de la toma de imágenes, que se haga en un lugar totalmente 

controlado, especialmente en cuanto a la luz, ya que los programas que hay disponibles, 

son muy susceptibles a errores de interpretación a la hora del reconocimiento de las 

marcas. 
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5.3 APÉNDICES 

 

5.3.1 APENDICE A  

 

Código del programa del PIC 

 

//Declaración de funciones 

void stopus10(void); // Hace un retraso de 10 microsegundos 

void stopms1(void);  // Hace un retraso de un milisegundo 

void interrupt(void);  // Función de interrupción de nuestro temporizador 
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void espera(void);  // Muestra en el display LCD el mensaje: “En espera” 

 

//---------------------Variables 

unsigned short centi, seg, centi2, seg2; 

unsigned short spresencia1, spresencia2, satasco1, satasco2, sfoto1, sfoto2, scaida1, 

scaida2; 

unsigned short actual, funcionar, motorcito, rodillos, nuevo, permitir; 

unsigned short primero, listo, detener, buscar, blocklcd, primerparo; 

 

//---------------------Programa principal 

void main(void) 

{ 

   OPTION_REG = 0b00000111; 

   TMR0 = 217; 

   INTCON = 0b10100000; 

    

   ADCON1 = 6; 

   TRISA = 0b000111; 

   TRISB = 0b11111111; 

   TRISC = 0b00000000; 

   TRISD = 0b00000000; 

   TRISE = 0b000; 

    

   PORTA = 0; 

   PORTB = 0; 

   PORTC = 0; 

   PORTD = 0; 

   PORTE = 0; 

    

   Lcd_Init(&PORTD); 
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   Lcd_Cmd(LCD_CURSOR_OFF); 

 

   espera(void); 

 

   centi = 0; 

   seg = 0; 

   centi2 = 0; 

   seg2 = 0; 

    

   spresencia1 = 0; 

   spresencia2 = 0; 

   satasco1 = 0; 

   satasco2 = 0; 

   sfoto1 = 0; 

   sfoto2 = 0; 

   scaida1 = 0; 

   scaida1 = 0; 

    

   actual = 0; 

   funcionar = 1; 

   motorcito = 0; 

   nuevo = 1; 

   permitir = 0; 

   primero = 1; 

   listo = 0; 

   detener = 0; 

   buscar = 0; 

   blocklcd = 0; 

   primerparo = 0; 
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   while(1) 

   { 

      if(PORTA.F0 == 1) 

      { 

         actual = 1; 

         detener = 0; 

      } 

      if(PORTA.F1 == 1) 

      { 

         detener = 1; 

      } 

      if(PORTA.F2 == 1) 

      { 

         PORTC.F0 = 0; 

         PORTC.F1 = 0; 

         PORTC.F2 = 0; 

         funcionar = 0; 

         primerparo = 1; 

         Lcd_Out(1,1, "Detenido         "); 

         blocklcd = 1; 

      } 

      else 

      { 

         if(primerparo == 1) 

         { 

            actual = 0; 

            funcionar = 1; 

            motorcito = 0; 

            nuevo = 1; 

            permitir = 0; 
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            primero = 1; 

            listo = 0; 

            detener = 0; 

            buscar = 0; 

            blocklcd = 0; 

            primerparo = 0; 

            espera(void); 

         } 

      } 

       

      if((PORTB.F0 == 0) && (PORTB.F1 ==0) && (actual == 1) && (blocklcd == 0)) 

      { 

         Lcd_Out(1,1, "Inserte mas hojas"); 

      } 

      if((PORTB.F0 == 1) && (PORTB.F1 ==1) && (actual == 1) && (blocklcd == 0)) 

      { 

         Lcd_Out(1,1, "En ejecucion     "); 

      } 

      if((actual == 1) && (funcionar == 1) && (nuevo == 1))    //-Motorcito on 

      { 

         stopus10(void); 

         spresencia1 = PORTB.F0; 

         stopus10(void); 

         spresencia2 = PORTB.F1; 

         if((spresencia1 == 1)&&(spresencia2 == 1)) 

         { 

            motorcito = 1; 

            PORTC.F1 = motorcito; 

            permitir = 1; 

            if(buscar == 0) 
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            { 

               centi2 = 0; 

               seg2 = 0; 

               buscar = 1; 

            } 

         } 

      } 

      if(motorcito == 1)                                       //-Motorcito off 

      { 

         stopus10(void); 

         satasco1 = PORTB.F2; 

         stopus10(void); 

         satasco2 = PORTB.F3; 

         if((satasco1 == 1) && (satasco2 == 1)) 

         { 

            nuevo = 0; 

            motorcito = 0; 

            PORTC.F1 = motorcito; 

            buscar = 0; 

            blocklcd = 0; 

         } 

      } 

      if((buscar == 1) && (seg2 >=5) && (centi2 >= 50))        //-Hoja atascada 

      { 

         if(blocklcd == 0) 

         { 

            Lcd_Out(1,1, "Hoja atascada    "); 

         } 

         blocklcd = 1; 

      } 
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      stopus10(void); 

      sfoto1 = PORTB.F4; 

      stopus10(void); 

      sfoto2 = PORTB.F5; 

      if((sfoto1 == 1) && (sfoto2 == 1)) 

      { 

         listo = 1; 

      } 

      if(listo == 1) 

      { 

         if((primero == 1) && (funcionar == 1)) 

         { 

            centi = 0; 

            seg = 0; 

            permitir = 0; 

            primero = 0; 

            PORTC.F2 = 1; 

         } 

         if((seg >= 0) && (centi >= 50) && (funcionar == 1)) 

         { 

            PORTC.F2 = 0; 

         } 

         if((seg >= 1) && (centi >= 50)) 

         { 

            permitir = 1; 

         } 

      } 

      if((actual == 1) && (funcionar == 1) && (permitir == 1)) //-Rodillos on 

      { 

         rodillos = 1; 
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         PORTC.F0 = rodillos; 

      } 

      if(permitir == 0)                                        //-Rodillos off 

      { 

         rodillos = 0; 

         PORTC.F0 = rodillos; 

      } 

      stopus10(void); 

      scaida1 = PORTB.F6; 

      stopus10(void); 

      scaida2 = PORTB.F7; 

      if((scaida1 == 1) && (scaida2 == 1)) 

      { 

         if(detener == 1) 

         { 

            actual = 0; 

            permitir = 0; 

            if(blocklcd == 0) 

            { 

               espera(void); 

            } 

         } 

         else 

         { 

            actual = 1; 

         } 

         nuevo = 1; 

         listo = 0; 

         primero = 1; 

      } 
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   } 

} 

 

// ----------------- F U N C I O N E S ----------------- 

void stopus10(void) 

{ 

   Delay_us(10); 

} 

 

void stopms1(void) 

{ 

   Delay_ms(1); 

} 

 

void espera(void) 

{ 

   Lcd_Out(1,1, "En espera        "); 

} 

 

void interrupt(void) 

{ 

   TMR0 = 217; 

   INTCON.F2 = 0; 

   centi++; 

   centi2++; 

   if (centi >= 100) 

   { 

      centi = 0; 

      seg++; 

      if (seg >= 120) 
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      { 

         seg = 0; 

      } 

   } 

   if (centi2 >= 100) 

   { 

      centi2 = 0; 

      seg2++; 

      if (seg2 >= 120) 

      { 

         seg2 = 0; 

      } 

   } 

} 

 

 

5.3.2 APENDICE B  

 

 

¿Por qué cámara web y no cámara digital, escáner convencional o escáner OMR? 

 

La respuesta es simple se eligió cámara web por estos beneficios que ellas nos aporta 

a diferencia de los demás. Como primer la cámara web podemos encontrarla en 

resoluciones altas (de hasta 8 mega pixeles) más que suficientes para las 

consideraciones que hemos hecho. 

 

 

La lente de la cámara web (en algunos modelos)  es la misma que usan cámaras 

digitales comerciales, nos referimos a la marca del lente Carl Zeiss que actualmente la 

usan muchas cámaras tales como las Sony cybershot y que es del tipo de sensor ccd y 
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no cmos como en cámaras web de precio muy bajo y que nos ofrece resoluciones 

también bajas del tipo VGA.  

 

 

Una ventaja para nuestro sistema a diferencia de las cámaras digitales usando cámara 

web es que el controlador de las cámaras web permite tomar capturas con la cámara e 

inmediatamente almacenarlas en disco duro cosa que no ocurre con las cámaras 

digitales pues estas al finalizar la toma de las fotos se tendrían que descargar las 

imágenes en la computadora para procesarlas y peor aún disponer de una memoria de 

alta capacidad en la cámara digital para no hacer el vaciado de las fotos 

constantemente en una sesión de trabajo. 

Otra ventaja es que por el mismo hecho de ser incluir cámara de video se puede utilizar 

posteriormente en este modo como  monitorización y así vigilar que esté ocurriendo con 

la hoja a capturar si ocurriese un problema. 

 

 

Del los escáneres OMR y convencionales se diferencia que para nuestro sistema el uso 

del OMR IMPLICARIA un gasto de alrededor de 40,000.00 pesos lo que la hace 

inasequible para la empresa y uno convencional que incluyera los requisitos que 

necesitamos costaría alrededor de 25,000 que aunque más barato que el anterior sigue 

siendo muy costoso, en cambio una cámara web con las prestaciones que necesitamos 

que claramente serian las de gama alta no deberían de pasar de los 2,000.00 según 

nuestras investigaciones. 
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5.3.3 APENDICE C 

 

MANUAL DE USUARIO DE REMARK OFFICE OMR 6.0 

 

Thank you for downloading a demo version of Remark Office OMR. In order to allow you 

to sample the functionality in the software, we have included this tutorial. The tutorial 

works with pre-supplied sample image files so that you can walk through the various 

steps of using the software. The sample files used in this tutorial are located in 

C:\Program Files\Principia Products\Remark Office OMR 6 Demo\Tutorial by default. (If 

you have installed the software in a different directory, look in that directory for a Tutorial 

folder.) 

This tutorial outlines how to create a form template for a basic survey form. It also detail 

show to process forms, correct the output and run a report. 

 

Note: While this tutorial uses a sample survey form, please note that Remark Office 

OMR can scan and process test forms, too. 

 

Please note that there are several ways to access basic software functions. Three of the 

most common methods include: 

 

 Getting Started Task Pane: The task pane on the left side of each Remark 

Office OMR window can be used to access the most common functions in the 

software. The task pane will automatically update based on the functions you 



 

 

60 

 

perform. You can show or hide the task pane by selecting the View menu and 

then clicking Task Pane. 

 

 Toolbar: The toolbar is the series of icons across the top of each Remark Office 

OMR window. These icons represent shortcuts for common functions within the 

software. Hover your mouse over any button to see tool tip text explaining the 

functionality of the button. 

 

 Menus: The pull-down menus have all of the functions available within the 

software. Many of these functions can also be found in the toolbar and task pane. 

 

It is up to you to decide how you wish to access software functions. We will work with all 

three methods to allow you an understanding of each. 

 

Before we begin, we need to touch briefly on some important concepts that may be new 

to you. Just take in the big picture for now; details will be built as these concepts are 

used in the lesson. 

 

 

Form Template Overview 

 

The following concepts are important to understand in performing this tutorial. Here is a 

quick overview to help you get started: 

 

What is a Form Template File? 

 

The first thing you will do in Remark Office OMR is create form templates for the forms 

you wish to process in the software. A form template file contains the information 

needed to instruct Remark Office OMR about each form. The form template conveys the 

location of the information on the pages (e.g., the bubbles the respondents will darken) 
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and the specifics of the data the user requires. The form template defines the backend 

database you will use for storage of the processed data. You will create a form template 

for each form that you wish to process using the software. 

 

How are Form Templates Created? 

 

Form templates are created by scanning an unmarked copy of the form to create an 

equivalent image in the Remark Office OMR Template Editor. You then use the mouse 

to drag boxes (called regions) around the marks (e.g., bubbles) and other areas you 

want to have recognized on your form. These regions tell the software where each piece 

of information you want to capture is located on the page and other pertinent information 

about the form. They also tell the software what type of data you need the software to 

output from each area. 

 

The Hospital Stay Evaluation Survey 

 

This tutorial will quickly teach you how to use the basic software functions and how to 

easily navigate the software’s user interface. You will create a form template for a 

hospital stay evaluation. This evaluation is a typical survey form containing several types 

of areas that Remark Office OMR will recognize, including a barcode, OMR bubbles and 

an area for gathering comments. The survey asks previous hospital patients to provide 

details about when and where they stayed and then answer some basic questions to 

evaluate their stay. A survey such as this one can be scanned to produce data and 

subsequently, reports to show how the hospital is performing. 

 

You will perform the following steps in this tutorial: 

 

 Create the Hospital Stay Evaluation form template 

 Process completed Hospital Stay Evaluation forms 

 Review and correct the data output 
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 Analyze the Hospital Stay Evaluation data with Remark Quick Stats 

 

Creating a Form Template for the Hospital Stay Evaluation Survey 

 

The Hospital Stay Evaluation tutorial is designed to provide you with experience in the 

basic functions of creating a form template and processing forms. The following 

procedures describe how to set up a form template for the sample Hospital Stay 

Evaluation form that is part of this tutorial. Subsequent sections of this tutorial will detail 

how to process forms and export or analyze the data. 

 

The form template creation process consists of: 

 

 Scanning an unmarked copy of the form (or importing an image of a previously 

scanned copy of the form) 

 

 Dragging boxes around the areas to be recognized 

 

 Providing Remark Office OMR with information about the data you need to collect 

 

To begin the Hospital Stay Evaluation form template 

 

1. If not already running, start the Remark Office OMR demo. 

 

2. Begin a new form template. Select the File menu and then click New form template. 

Alternatively, in the left-hand panel, known as the Task Pane, select New form 

template. Any of these actions will open a second window containing the 

Remark Office OMR Template Editor. 
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Tip: If you use File|New form template or the New form template link in the Task 

Pane, the Template Editor will open with the new form template window already opened 

for you. 

 

3. If the Template Editor opens but you do not see the New Form Template Properties 

window, select the File menu and then click New. 

 

The New Form Template Properties window opens. The New Form Template 

Properties window is where you describe your form to Remark Office OMR. You will do 

this by entering basic information about your form, including the form template 

description, page size and page orientation. 

 

4. Enter Hospital Stay Evaluation in the Form template description box. 

 

5. Locate the Page Size area where you can tell the software the size paper your form 

uses. Select US Letter in the Size drop-down list. 

  

6. Locate the Orientation area and select Portrait. 

 

7. Click the Next>> button to continue. 

 

The Create Page Elements window appears. The Create Page Elements window 

allows you to either acquire an image of your form from your scanner, or acquire an 

image of your form from an existing image file. Each page in a form template is created 

using an image of the appropriate page in your form. The image allows you to see the 

form so that you can easily teach Remark Office OMR how to read it. 

 

To obtain a form template image 
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As previously mentioned, there are two ways to acquire an image for a form template 

page. Images can be acquired by scanning to create a new image file or by opening an 

existing image file. For the purposes of this demo, we will use the supplied image files. 

 

1. To acquire an image, locate the Select Method to Use for Image Acquisition area 

of the window. Beneath it are two choices, Read from scanner and Read from image 

files. 

 

2. Click the radio button for Read from image files in the Select Method to Use for 

Image Acquisition area. 

 

3. Click the Acquire Images from File button. The Select Images window will open. 

 

4. Select the Tutorial 1 – Hospital Stay Evaluation.pcx file from the Tutorial folder of 

your Remark Office OMR Demo installation directory (e.g., C:\Program 

Files\Principia Products\Remark Office OMR 6 Demo\Tutorial) and then click the 

Open button. 

 

Once an image is acquired either by scanning or by opening an existing image file, the 

Template Editor will display a thumbnail of the image for your approval. 

 

5. When a thumbnail image of your form appears, click the OK button to accept the 

image. 

 

6. Once the thumbnail image is accepted, the Template Editor will open the new 

template where you can begin to define the regions. 

 

To define form template regions 
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The purpose behind making a form template is to tell the software where to locate the 

information on your specific form and how to understand your data requirements. 

As you create the form template, you will designate different areas where you want 

Remark Office OMR to recognize marks on your form and convert them into data. You 

will accomplish this by dragging boxes around areas containing barcodes, OMR marks 

or written comments. Barcodes, OMR marks and written entries are three differing types 

of information requiring three specific methods of capture. The software employs three 

types of regions to accomplish this task. 

 

The following table details the three region types employed by Remark Office OMR: 

 

 

 

 

The following table lists the six regions on the Hospital Stay Evaluation form and their 

corresponding region types: 
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Tip: You can change the way you see the image portion of the screen by using the Fit 

Height and Fit Width buttons on the toolbar. For the tutorial, it is recommended that You 

use the Fit Width setting and also maximize the window as you normally would do in a 

Windows environment. To change the magnification of the image, use the Zoom In and 

Zoom Out buttons on the toolbar. 

 

To define the Hospital Division as a Barcode region 

 

The Hospital Division barcode will be defined as a barcode region. The advantage to 

using a barcode is that Remark Office OMR can read and enter the information collected 

from the barcode directly into your data without the need for any manual data entry.  

 

1. Highlight the Page 1 node on the left side of your screen if it is not already highlighted. 
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2. Select the Page menu, click Insert and then click Barcode Region After 

SelectedPage, or click the orange toolbar button. Alternatively, select the Define 

regionslink in the Task Pane and then select Insert Barcode region. 

 

The mouse changes to a crosshair. 

 

3. To create the Barcode region place the cursor just beyond the top left of the barcode, 

then press and hold the left mouse button while dragging the rectangle beyond the 

bottom right corner of the barcode, making sure you have selected the entire allotted 

space. Because barcode length may vary depending on the text of each barcode, 

capture a little extra space at the end of the barcode to accommodate the largest 

possible barcode you might process. 

 

Tip: When creating form templates for your own forms that include barcodes, use a 

blank copy of the form with the longest barcode you intend to process for the form 

template. By creating the region around the longest barcode you have, you will be 

ensured that the region will be large enough to capture all barcodes you will be 

processing. 

 

4. After positioning the box, release the mouse button and the Properties - Barcode 

Region window will appear to allow you to define the region’s properties. This window 

allows you to provide pertinent information about the barcode. 

 

Tip: You can use your cursor to drag/slide the Properties box on your screen if you need 

to see anything on your form. Do not worry if the region is not drawn perfectly at this 

point because you will easily be able to adjust it by dragging the borders as needed after 

the region’s properties are defined and the Properties - Barcode Region window is 

closed. 
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5. Type Hospital Division in the Region name box. The Region name provides a brief 

description of the region and will become the name for this column in your data set. 

 

6. Set the Barcode type to Auto Detect and the Barcode orientation to Horizontal. 

 

These settings allow you to set specific barcode types and/or positioning if your form 

design ever requires it. 

 

7. Click the OK button to return to the main Template Editor window. You will now see 

an orange box around the barcode in the image area, identifying it as a Barcode region. 

 

Progress Note and Tip: Have you noticed the region you defined in the form template 

is now represented in the list on the left of your screen? This list is referred to as the tree 

view. The order of the regions as displayed in the tree view will determine the order of 

the fields in the data set you create. If needed, within any single page, these region 

nodes can be dragged and dropped into a preferred order for your resulting data set. 

 

To define the Hospital Unit as an OMR region 

 

1. Highlight (if not already highlighted) the Hospital Division node by clicking it in the 

tree view. 

 

2. Select the Region menu, click Insert and then click OMR Region After Selected 

Region, or click the green toolbar button. Alternatively, select the Insert OMR region 

link in the Task Pane. 

 

The mouse changes to a crosshair. 
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3. Place the cursor just to the left of the top bubble in the column of marks representing 

the Hospital Unit, then press and hold the left mouse button while dragging the rectangle 

to the bottom right corner of the region, capturing all four bubbles in the region. 

 

Tip: When defining an OMR region, include only the actual marks; never include the 

nearby labels, text, etc. Also, create a buffer space between the marks and the edge of 

the defined region. This buffer will allow Remark Office OMR to accommodate minor 

shifting or skewing during form processing and decrease the number of exception cases 

you will need to clean in the resulting data. 

 

After positioning the box, release the mouse button. The Properties - OMR Region 

window appears. The Properties - OMR Region window allows you to enter information 

that will define the OMR region and the data it produces, including: 

 

 Region Definition (the area containing Region name, the type of OMR region or 

OMR type and the Data type). 

 

 Region Layout of the region (the area detailing how many Rows and Columns of 

marks are contained in the region). 

 

 Possible Responses (the Labels you actually want to see as your data). 

 

4. In the Region Definition area, enter Hospital Unit in the box titled Region name. 

 

5. For the Region type, select Multiple. The Multiple region designation is used for 

typical multiple choice style questions. 

 

Note: There are other types of available OMR regions, which can be seen if you click 

the down arrow to the right of Multiple. These additional region types offer differing types 

of data output. 
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6. For the Data type, select Textual. This region contains hospital unit names, so 

textual data is appropriate. When creating your own form templates, the data type you 

select can be textual or numeric, depending on the type of data you require. 

 

7. In the Region Layout area to the right, select Column for Region orientation. 

Region orientation lets Remark Office OMR know how the region is structured on the 

form. For this question, the question’s answer choices are listed in one column. 

 

8. Enter 1 in the Columns in the region box and 4 in the Rows in the region box. 

The region size lets Remark Office OMR know how many rows and columns of marks 

are in the region. 

 

9. Locate the Labels area, and then type in the text for each unit: Maternity, Cardiac, 

Pediatric, ICU, one per line. Your choice of Labels in the form template determines what 

you will see in the data set when your filled in forms are processed. The Labels 

represent the response choices for each bubble, moving from top to bottom. You will 

notice that as you type the Labels, numbers will automatically fill the Values column to 

the right. While the Labels represent the actual data you will see returned from the 

processed forms, the Values represent the information Remark Office OMR uses to 

perform any statistical analysis. 

 

Tip: When entering Labels into Possible Reponses, you may use the Enter key to move 

to the next row. 

 

10. Click the OK button to return to the main Template Editor window. 

You will now see a green box around the Hospital Unit region in the form area, 

identifying it as an OMR region. You will also see that Hospital Unit has been added to 

the tree view on the left side of the Template Editor. 
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To define Length of Stay as an OMR region 

 

The Length of Stay in Days region is a second OMR region designed to output the 

number of days the respondent stayed in the hospital. The steps involved in creating this 

OMR region will be the same as for creating the OMR region for Hospital Unit. You will 

notice that many of the region’s properties will change to reflect that the area on the form 

has a single row with five columns instead of a single column with four rows. 

 

1. Highlight (if it is not already highlighted) Hospital Unit by clicking its node in the tree 

view. 

 

2. Select the Region menu, click Insert and then click OMR Region After Selected 

Region, or click the green toolbar button. Alternatively, select the Insert OMR region 

link in the Task Pane. 

 

The cursor changes to a crosshair. 

 

3. Place the cursor just to the top left of the row of marks representing the Length of 

Stay, then press and hold the left mouse button while dragging the rectangle to the 

bottom right corner, capturing all of the bubbles in the region. 

 

4. In the Region Definition area, enter Length of Stay in the box titled Region name. 

 

5. For the Region type, select Multiple. 

 

6. For the Data type, select Textual. This region contains numbers of days but because 

one of the choices (5+) is not numeric, textual is the correct data type. 
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7. In the Region Layout area to the right, select Row for Region orientation. Region 

orientation lets Remark Office OMR know how the region is structured on the form. For 

this question, the question’s answer choices are listed in a row. 

 

8. For Columns in the region, enter 5 and for Rows in the region enter 1. 

 

9. For the Labels area, type the number for each length of stay on each of the rows: 1, 2, 

3, 4, 5+, one per line. This label range represents the response choice for each bubble, 

moving from left to right. Again you will notice that as you type the Labels, numbers will 

automatically fill the Values column in the grid. 

 

10. Click the OK button to return to the main Template Editor window. 

 

You will now see a green box around the Length of Stay region in the form area, 

identifying it as an OMR region. You will also see that Length of Stay has been added to 

the tree view. 

 

To define Room Number as an OMR region 

 

The Room Number region needs to capture all five digits as one piece of information. To 

do this we will employ a Grid OMR region to define the bubbles on the form. A Grid 

OMR region outputs a single piece of data regardless of the number of rows and 

columns included in the region. This type of region is used for items such as dates, ID 

numbers, social security numbers, etc. 

 

The steps involved to create a Grid region will be the same as you used to create the 

OMR regions we have already created. However, the specific properties of the region 

will change to reflect the way the region is formatted on the form and the way we want 

the software to report the data. 
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1. Highlight (if not already highlighted) the Length of Stay node in the tree view, click 

the green toolbar button to insert an OMR region, and then draw the OMR region box 

around the entire group of bubbles. 

 

2. After positioning the box, release the mouse button, and the Properties - OMR 

Region window appears. 

 

3. In Region Definition area, enter Room Number in the Region name box. 

 

4. Select Grid for the OMR type. 

 

5. Select Numeric for the Data type. We will be capturing a five digit number. 

 

6. In Region Layout area, select Column for the Region orientation. Each column in 

this region represents one digit of the room number. 

 

7. In the Columns in region box, enter 5 and in the Rows in region box, enter 10. 

 

8. Enter the appropriate Labels in Possible Responses. For the Labels area, click the 

down arrow for Possible label scales and choose the scale 0 to 9 from the list of 

choices. This range represents the response choices for the bubbles in all five columns, 

moving from top to bottom. The numbers will fill the Labels grid automatically. The 

Labels represent the actual data that will be returned from the processed forms when 

filled in by the respondent, and the Grid region will return all selections to make a five 

digit number. 

 

9. Click the OK button to return to the main Template Editor window. 
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You will now see a green box around the Room Number region in the form area, 

identifying it as an OMR region. You will also see that Room Number has been added to 

the tree view. 

 

To define the Hospital Stay Evaluation questions as an OMR region 

 

There are six questions on the form that ask the patient to evaluate his or her hospital 

stay. All six questions share the same evaluation scale of Strongly Agree to Strongly 

Disagree, which allows them to share one set of labels on the form. This compact and 

logical question area can be captured with a single OMR region even though it contains 

six separate questions. Defining similar questions in one region saves time and effort, 

and is preferable. 

 

1. Highlight (if not already highlighted) the Room Number node in the tree view. 

2. Click the green toolbar button to insert an OMR region, and use the crosshair to draw 

a box around the entire group of 24 bubbles (all four columns and six rows). This region 

contains six individual questions and each question has four possible answer choices. 

 

3. When the Properties – OMR Region box opens, enter Evaluation in the Region 

name box. 

 

4. Select Multiple for the OMR type. 

 

5. Select Textual for the Data type. This region contains a scale from Strongly Agree to 

Strongly Disagree, so textual data is appropriate. 

 

6. In the Region Layout area, select Row for the Region orientation because each 

individual question occupies one row of the region. 

 

7. Enter 4 in the Columns in the region box and 6 in the Rows in the region box. 
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8. In the Labels grid, enter the correct Labels: Strongly Agree, Agree, Disagree and 

Strongly Disagree, one per line. 

 

9. In the Task Pane, select Question text and names. The next step will be to enter the 

Question Text for each of the six questions. 

 

Tip: Question Text appears on the reports generated in Remark Quick Stats and is 

useful when exporting to some data formats. Question Names can be used to enter 

individual names for every question within one OMR region. If the Question Names grid 

is left blank, the software will use the Region Name defined on the previous screen and 

append sequential numbers to the end of the name to differentiate the questions.  

Individual. Question Names are useful if you are exporting data to an existing file that 

requires specific field names (e.g., an Access table). For the purpose of this tutorial, we 

will only enter Question Text 

 

10. Enter the Question Text for each of the six questions as shown below. 

 

Question Text: 

 

1. Admission procedures were well-handled. 

2. The staff looked after my comfort and well-being. 

3. The staff treated me with respect. 

4. Medical procedures were explained in terms I understood. 

5. My doctor was confident and knowledgeable. 

6. My overall rating of this hospital is favorable. 

 

11. Click the OK button to return to the main Template Editor window. 
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You will now see a green box around the Hospital Stay Evaluation region in the form 

area, identifying it as an OMR region. You will also see that Evaluation has been added 

to the tree view. 

 

To define the Comment area as an Image region 

 

Areas in which you expect your respondent to use handwriting can be captured by 

Remark Office OMR as Image regions. Image regions can either take a snapshot of the 

handwriting and store it on your computer as an image file, or can allow you to hand 

enter the written information into your data set using image assisted data entry. In either 

case, you can run a Respondent Report in Remark Quick Stats to view the information 

from the Image region. 

 

1. Highlight (if not already highlighted) the Evaluation node in the tree view and then 

click the blue toolbar button to insert an Image region. 

 

2. Once the cursor becomes a crosshair, place the cursor at the top left of the area 

where you would expect the respondent to enter their comments. Press and hold the left 

mouse button while dragging the rectangle to the bottom right corner of the area, making 

sure you have selected the entire allotted space. 

 

3. After positioning the box, release the mouse button and the Properties – Image 

Region window will appear to allow you to define the region’s properties. 

 

4. Enter Comments in the Region name box. 

 

5. Set the Region type to Data entry. This type will allow you to hand enter the 

comments that are written on the forms. 

 

6. Set the Data type to Textual. 
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7. At the bottom of the Region Definition area, mark the setting for Attempt to detect 

the presence of handwriting in the region. By using this feature, Remark 

Office OMR will search for handwriting in the Image region area during form processing. 

If writing is found, the area will show a visible indicator that text was found so that you 

know exactly where you need to enter information. 

 

8. Click the OK button to return to the main Template Editor window. You can now see 

the new Image region visible as a blue field on your form and that Comments is now 

listed in the tree view of your form template. 

 

To save the Tutorial form template 

 

Once you have defined all of the regions on your form, you may save the form template. 

(You may also save as you go, which is recommended for normal use of the product.) 

 

1. Select the File menu and then click Save. Alternatively, select the Save template link 

in the Task Pane. 

 

2. In the File name box, type Tutorial and then click the Save button. 

 

Note: If someone has already completed the tutorial with this file name, you may modify 

the file name. 

 

3. You have now created the Tutorial form template. Close the Template Editor by 

selecting the File menu and then clicking Exit. Alternatively, you may also simply click 

the X in the upper right hand corner of the Template Editor window. 

 

Processing the Completed Hospital Stay Evaluations 
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Now that you have created the form template for the Hospital Stay Evaluation survey 

you are ready to begin processing the completed forms the supplied image files. (While 

you could scan forms at this point, for purposes of this tutorial, we will read the supplied 

image files.) 

 

To open the Hospital Stay Evaluation form template 

 

1. If not already running, start the Remark Office OMR Data Center. When the Data 

Center opens, it will display a blank spreadsheet-style data grid. The Data Center offers 

a Task Pane on the left containing the most commonly requested actions. 

 

2. Select the File menu, click Open and then select Form Template. Alternatively, 

select the Open form template link in the Task Pane. You must open a form template in 

order to process forms. 

 

3. Select the Tutorial.omr file (or the file you created in the previous section of this 

tutorial) and then click the Open button. (The .omr file extension is the one used for all 

Remark Office OMR templates.) 

 

When the Tutorial form template opens, its name will appear on the title bar at the top of 

the screen and you will see the region names you specified as your column headers in 

the data grid. Each column in the grid corresponds with one variable or question in the 

form template, as the column headers indicate. Each grid row will contain information 

from one processed form regardless of the number of pages the form contains. The data 

grid will fill row by row as your completed forms are processed. 

 

To read from image files 

 

The Read Wizard is used to process forms. We will be reading image files that resulted 

from scanning filled in forms previously. 
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1. Select the Tools menu and then click Read Wizard. Alternatively, select the Read 

Wizard link in the Task Pane. 

 

The Read Method window appears. 

 

2. In the Select Method to Use for Data Collection area, mark the radio button for 

Read from image files. 

 

3. Click the Next>> button to continue. 

 

The Image Selection window appears to enable you to select the images you want to 

process. 

 

4. From the listed image files select HospitalStay1.pcx, HospitalStay2.pcx and 

HospitalStay3.pcx, respectively by clicking them as you hold down the Ctrl key. 

(Note, by default, these images are installed to the Tutorial folder on your system, 

e.g., C:\Program Files\Principia Products\Remark Office OMR 6 Demo\Tutorial.) 

5. Click the Add Selected Images button to move them into the Images in Read 

Order window on the right. 

 

Tip: You can use the Ctrl or Shift keys to select multiple image files and then use the 

Add Selected Images button to move the images to the Images in Read Order window. 

 

6. Click the Next>> button to continue. 

 

The Review Exceptions window appears. This window allows you to configure options 

for reviewing exception cases such as blank and multiple responses. We will not be 

using this feature in this tutorial. 
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7. If the Activate Review Exceptions checkbox is marked, click in the checkbox to 

deselect this option. 

 

8. Click the Read button to begin reading image files. 

 

As each image is processed you will see a row added to the data grid. 

 

Reviewing and Correcting the Data 

 

After the three forms have been processed, three rows of data will be displayed in the 

data grid. Each row represents the responses collected from one of the three forms. You 

are now ready to inspect the data for missing or unrecognized responses in order to 

prepare for either analysis or export. 

 

How does the software handle data exceptions? 

 

Remark Office OMR informs you of unrecognized or questionable responses by placing 

a visible marker in each appropriate data grid cell. Each one of the six types of 

problematic or potentially inaccurate data is represented by a specific color flag. The 

Exceptions Legend in the Task Pane provides an easy reference key to the six 

exception flags and their meanings. 

 

The software will then assist you to correct exception cases or problems by allowing you 

to see what was entered on the actual form. The stored images for each processed form 

will be available to show your respondents’ answer choices. You can click inside any cell 

to view the corresponding image of that form. (If you click in a cell and do not see an 

image beneath the data grid, select the View menu and then click Image Viewer to open 

the Image Viewer.) 

 

To run Review Exceptions 
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1. Select the Tools menu and then click Review Exceptions. Alternatively, select the 

Review exceptions link in the Task Pane. 

 

The Review Exceptions window will appear in the Task Pane. 

 

2. The top half of the pane allows you to select the search cases (e.g., multiple 

responses, blank responses, etc.). Make sure Multiple responses and Blank 

responses are checked. 

 

3. The bottom half of the window allows you to configure and begin the search. You may 

search by Row/Respondent (across rows) or by Column/Item (down the columns). For 

this tutorial, select Row/Respondent. 

4. Click the Begin Review button to start the automated review. The software will 

search through the data set to locate the flagged cells. 

 

The first piece of flagged data is a multiple response in the first grid row for the item 

called Comfort. In the Review Exceptions window, you will see a green flag and 

Response for [Evaluation2]. The green flag tells you that a multiple response was 

encountered. The text in the brackets ([Comfort]) tells you the question or item where 

the multiple response was encountered. 

 

5. In the box beneath Response for [Evaluation2] use the drop-down list to select the 

appropriate response. Use the Image Viewer beneath the data grid to review the 

respondent’s form. It appears that the patient changed his response from Agree to 

Strongly Disagree by crossing out the original mark and filling in a second bubble. 

We will assume that Strongly Disagree is the correct response. Select Strongly 

Disagree from the drop-down list. 
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6. Click the first green arrow, titled Search Forward to move to the next exception. Or, 

simply press Enter. 

 

7. The next exception is a multiple response in row one for the item called Evaluation3. 

 

Look at the Image Viewer to see the intended response. In this case, it looks like the 

respondent also changed his response from Agree to Strongly Disagree. Select 

Strongly Disagree from the drop-down list. 

 

8. Click the first green arrow, titled Search Forward to move to the next exception. Or, 

simply press Enter. 

 

The next exception is an image region where handwriting was detected in the first row of 

data for the item called Comments. The software uses a blue flag to mark Image 

regions that contain writing and may require data entry (when using the 'Automatically 

attempt to detect the presence of handwriting in the region' feature). 

 

9. In the box beneath Response for [Comments] type the comment displayed in the 

Image Viewer: Mrs. Smith was not a very nice person! 

 

10. Click the first green arrow, titled Search Forward to move to the next exception. Or, 

simply press Enter. 

 

The next exception is another image region where handwriting was detected in the 

second row of data for the item called Comments. 

 

11. In the box beneath Response for [Comments] type the comment displayed in the 

Image Viewer: Mrs. Smith was very kind and generous! 

 

12. Press the Enter key. There are no more exception cases in the data. 
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13. When prompted, click Yes to the message Are you sure you are finished 

reviewing exceptions?. 

 

14. Click the Back button in the Review Exceptions pane to return to the regular Task 

Pane. 

Your data is now ready to be saved and analyzed. In the full version of Remark Office 

OMR, you may save data to over 30 file formats. This feature is not available in the 

demo, so we will continue to the analysis section of this tutorial. 

 

Analyzing the Hospital Stay Evaluation Data 

 

Remark Office OMR provides statistical analysis functionality for tabulating data from 

your forms. (Note: The software will also grade test data.) The Easy Survey feature is 

one such facility and will provide you with a choice of standard reports based on your 

data. 

 

To tabulate the Hospital Stay Evaluation data 

 

1. Select the Tools menu, then click Analysis and then click Easy Survey. 

Alternatively, click the Analysis tab and then select the Easy Survey link in the Task 

Pane. 

 

The Remark Quick Stats window appears. 

 

2. In the Task Pane, select the Display reports link to view the selection of available 

reports. 

 

3. Select the Condensed Item Analysis Report link in the list; the report will display 

on the right. 
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The Condensed Item Analysis Report shows several statistics for each question, such 

as Label, Total and Percent. Each table displays statistics for a separate question in the 

survey. This simple, straightforward report may be all that you need to communicate 

your survey’s results. 

 

4. To view another report, select the Detailed Item Analysis Report link. The 

Detailed Item Analysis report provides a more detailed look at individual question 

statistics, including frequency, percent, valid percent and cumulative percent. A 

corresponding graph is also displayed by default. 

 

5. View each page by using the Previous Page and Next Page buttons located in the 

upper left area of the report window. Because the report opens to page 1, only the 

Next Page button is enabled initially. The box to the right will display the report page you 

are currently viewing (e.g., 1/8). 

Although we will not view every available report in this tutorial, you will want to  explore 

the other available reports and experiment with the report options by clicking 

Tools|Report Properties and Tools|Preferences. 

 

The full version of Remark Office OMR allows you to export reports to several formats, 

including PDF, HTML, RTF and Excel. This feature is not available in the demo. 

 

Tutorial Summary 

 

This tutorial illustrated the basics of using the software, including: 

 

 Creating a form template 

 Processing forms 

 Reviewing data 

 Analyzing the results 
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Now that you know how to use the software, you may use this demo to try out your own 

forms. We hope this tutorial has demonstrated some of the capabilities of Remark Office 

OMR. For a complete list of features, please visit our web site at 

www.principiaproducts.com. 
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